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 1.0 Revit Setting and Configuration
- Set up folder structure, file location

 “Work In Progress” Data Repository

 Verified Shared Data

 Issuing Data

 Archived Data Repository

 Incoming Data Repository

 Project Support Files

 Project Document Files
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 2.0 Revit Setting for Project Team Collaboration
- Create central model

The central model stores the current ownership information for all 
worksets and elements in the project, and acts as the distribution 
point for all changes made to the model. All users should save their 
own local file, edit locally in this workspace, and then synchronize 
with central to publish changes to the central model so that other 
users can see their work.

Workset Name Descriptions
SITE Landscaping, anything outside building
EXTERNAL ENVELOPE Facade
VERTICAL 
TRANSPORTATION

Lift, staircase escalators

HIDDEN Temporary elements for co-ordination but not for 
drawing production e.g. Structural walls at 
preliminary design stage

LEVEL L01 Project broken by levels

When you work on a workshared project, you can specify an active 
workset to work with.  Once you select the workset, all new model 
elements you create in the project, will then be contained in the 
active workset.

- Create worksets
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 3.0 Naming Convention

Naming of model files shall be based on CIC BIM Standards. For full compliance, recommended character restrictions should be adopted. 

- Model Files

Field 1: Project (1 to 8 alphanumeric)
User definable project reference coding.

Field 2: Author (3 alphanumeric)
Can use the list of agent responsible codes which can be downloaded
from the Development Bureau web site.

Field 3: Zone (2 alphanumeric)
Identifier of which building, area, phase or zone of the project the model
file relates to if the project is sub-divided by zones. For infrastructure
(linear) the zone may be replaced by a location defined as a chainage
and offset.

Field 4: Level (2 alphanumeric)
Identifier of which level, or group of levels, the model file relates to if the
project is sub-divided by levels.

Field 5: Type (2 alphanumeric)
Document type, which will be M3 for 3D model files or QT for quantity
take off.

Field 6: Role (2 alphabetic)
Indicates the discipline. For list of ID’s refer to table below.

Field 7: Description (1 to 8 alphanumeric)
Descriptive field to define the type of data portrayed in the file. Avoid
repeating information codified in other fields. Can be used to describe
any part of the previous fields, or to further clarify any other aspect of the
contained data.

ID Discipline
AR Architect
BS Building Surveyor
CL Client
CN Contractor
CV Civil Engineer
DR Drainage Engineer
EE or EL Electrical Engineer
FM Facilities Manager
FS Fire Services Engineer
GE Geotechnical Engineer
GS Geographical Information System Engineers or land surveyors
HY Highways Engineer
IN Interior Designer
LS Land Surveyor
LA Landscape Architect
ME Building Services Engineer, MEP Engineer
MV or AC Mechanical Ventilation & Air Conditioning Engineer
PL Plumbing Engineer
PM Project Manager
QS Quantity Surveyor
SC Sub-Contractor
ST Structural Engineer
TP Town Planner

7

Description

6

Role

5

Type

4

Level

3

Zone

2

Author

1

Project



ADVANCED CONSTRUCTION INFORMATION DEVELOPMENT

Basic Setting

 3.0 Naming Convention

View naming shall be consistent across all references to that view. Renaming of views shall be carried out with care as any changes will be 
automatically reflected across all documentation. 

- View Naming

Field 1: Level (Optional)
Concise description of the content and purpose of the view

Field 2: Content
Where appropriate, further clarification of the location of information shown

Name  

LEVEL 1 – FLOOR PLAN 

LEVEL 1 – CEILING PLAN 

LEVEL 3 – DETAIL PLAN AT ELEVATOR 1 

NORTH-SOUTH BUILDING SECTION 

WALL SECTION 1 

SOUTH ELEVATION 

- Drawing Sheet Naming

Sheet naming shall be based on the Document and Drawing Numbering protocols established for the project. These names automatically 
match the text as it appears in the titleblock and any schedules. 

2

Content

1

Level
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 3.0 Naming Convention
- Families Naming

Family Name DOR-SGL-AEC-Wood-w_Louver.rfa Descriptions
Category DOR-SGL-AEC-Wood-w_Louver.rfa A Door, DOR is the short from of the Category type “door”

Functional Type DOR-SGL-AEC-Wood-w_Louver.rfa A Single Door, SGL is the short from of the functional type

Originator DOR-SGL-AEC-Wood-w_Louver.rfa AEC is the short from of the default Architecture-Engineering-Construction Industry. 
It can be replaced by the name of the creator in short from of three characters.

Descriptor 1 DOR-SGL-AEC-Wood-w_Louver.rfa A door is made of Wood. An optional descriptive text

Descriptor 2 DOR-SGL-AEC-Wood-w_Louver.rfa A door is built with Louver. This text further describes the Family

File Extension DOR-SGL-AEC-Wood-w_Louver.rfa Revit Family File Extension

Format
<Category> - <Functional Type> - <Originator> - <Descriptor 1> - <Descriptor 2>

- Type Naming

Type names should indicate the key differences between types (size, 
count, material) and, when applicable, reflect standard sizes. In 
some cases, you may base names on size difference, but use 
common terms rather than numbers.

*Do not include the family name or category in the name.

Below is an example of a Window Family with different Family Types
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 4.0 Define Grid, Level, Project Base Point and Survey Point
- Adding Grid - Adding Level

- Project Base Point

Grid Grid are 3D elements that are visible only in views that intersect the grid extents. Structural columns automatically 
join to grid intersections.

Level These elements are usually visible only in a 2D view. They can be used to move any model element that references 
them.

Project Base Point Common point for Linking File (Usually Cross of Gridline)

Survey Point Actual Geographical location according to survey plan

- Survey Point
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 5.0 Define True North and Project North
- True North

Specify an angle on the 
Options Bar or click in the 
view to define the angle.

To see the change reflected in 
a particular view, edit view 
properties to change the 
Orientation parameter to True 
North.

- Project North

Model elements and detail elements rotate the 
specified angle in the drawing area. The view’s 
Orientation property should always set to 
Project North.
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 6.0 Link Revit models from different disciplines
- Link Revit

The most straightforward method to insert a Revit link is to use the Link Revit tool on the Insert tab. It can connect link Revit models from 
different disciplines.

Defines the common coordinate system for all BIM data.  DWG/DGN can also be inserted into Revit project but the common 
coordinate would be different.

- Shared Coordinates
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 7.0 Copy & Monitor Grid line & Level from Arch Model

When multiple teams collaborate on a project, effectively monitoring and coordinating work can help to reduce mistakes and 
abortive works.

- Copy & Monitor
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 8.0 Create Location Plan & Boundary Line

In the new project to Revit, open “Site” view in Floor Plans  Link 
Site plan CAD  the scale set up to 1:2000

- Location Plan

- Boundary Line

In the Plan view  Click Massing & Site tab  Modify Site panel 
Click “Property Line”  Create by sketching
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 9.0 Phasing

To define project phases and apply phase filters to views and schedules to show various stages of work of project.

- Phasing

Phase Filters Definition

None Does not apply a phase filter to the view. The view displays all elements from all phases.

Show All Shows new elements and existing, demolished, and temporary elements.

Show Complete Shows the completed project, after demolition and new work have been performed in the current phase.

Show Demo + New Shows demolished elements and all new elements added to the building model.

Show New Shows all new elements added to the building model.

Show Previous + Demo Shows existing elements and demolished elements.

Show Previous + New Shows all original elements that were not demolished (Show Previous) and all new elements added to the 
building model (+ New).

Show Previous Phase Shows all elements from the previous phase. In the first phase of a project, existing elements are new to that 
phase, so applying the Show Previous Phase filter causes no elements would be displayed.

- Display of Phase Filters

All project/template contains the following default phase filters:
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 9.0 Phasing

All project/template contains the following default phase Status:

- Phase Status

- Graphic Override in phasing

Material for phasing features shall be set as follow:

Phase Filters Definition

New Element was created in the phase of the current 
view.

Existing Element was created in an earlier phase and 
continues to exist in the current phase.

Demolished Element was created in an earlier phase and 
demolished in the current phase.

Temporary Element was created and demolished during the 
current phase.

Status Material Name Color Code

Existing Phase - Exist RGB 127-127-127

Demolished Phase - Demo RGB 250-000-000

New Phase – New RGB 080-080-080

Temporary Phase - Temporary RGB 000-000-127
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 10.0 Define Text Font

All text shall be restricted to the following sizes (Fonts : Arial Narrow):

-Text Assignment

Text Height (mm) 
Plotted

Line
Weight

Usage

1.8 2 General text, dimensions, notes – used on A3 & A4 size drawings

2.5 3 General text, dimensions, notes

3.5 4 Sub-headings,

3.5 5 General text, dimensions, notes – A0 drawings

5.0 7 Normal titles, drawing numbers

7.0 8 Major titles

*Alternative text sizes shall not be used without the consent of the BIM Co-ordinator.

1.8mm 2.5mm 5.0mm 7.0mm3.5mm
Line Weight : 4

3.5mm
Line Weight : 5
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 11.0 Material Setting

On the Manage tab  Settings Panel  Click “Materials”  Select 
Material in the left list  Set up Graphic in the Graphic tab on the 
right  Click “OK”

- Material Browser - Asset Browser

Material Browser  Click            In the Asset Browser  Select 
the material double-click    
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 12.0 Transfer Project Standards from other project

In the exercise project file there are some custom wall types you want to copy into a new project.

- Transfer Project Standards

New Only will copy only walls that are not currently in the new 
project.

This is especially important to verify if you have more than two 
project files open to ensure that you copy from the expected file.
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 13.0 Drawing Revision

In the Sheets view  Annotate tab  Detail panel  Click “ Revision Cloud”  Create Revision Cloud Sketch  Finish the edit mode

- Revision Cloud

Add a revision cloud to the current view or sheet to indicate design areas that have changed.

- Revision dialog

Specify the minimum arc length for revision clouds in the project on 
the Sheet Issues/ Revision dialog.
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 14.0 How to Archived Model
- eTransmit

With eTransmit for Revit software products, user can copy a Revit 
model and link files to a single folder for internet transmission.

- Export to DWF / DWFx

User can export a Revit model to DWF or DWFx format, so user 
can share the model with others who do not have Revit.
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 15.0 3D Grid and Multi-segment for curved grid

In Revit, users cannot display and draw grid line in 3D View, so need to create family (Template : Metric Generic Model line based) for the 
3D Grid.

- 3D Grid

User can use Multi-Segment to sketch grids requiring more than one segment  

- Multi-segment grid



Skills for Modeling
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 1.0 Select Element in View
- Tab

Key Action

CTRL Select multiple elements

TAB Cycle through the pre-highlight of elements to select among ones that are close to one another

TAB Pre-highlight wall faces or wall centerlines when placing dimensions

TAB Toggle between selecting a curtain wall or a glazed panel in a plan view

SHIFT + TAB Reverse the order in which TAB cycles through the pre-highlighting of elements

CTRL + A Select all rows in the Worksets dialog
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 2.0 Detail Level & Visual Style
- Detail Level

Set the detail level for newly created views based on a view scale.

Coarse Medium Fine
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 2.0 Detail Level & Visual Style
- Visual Styles - Specify graphic styles

You can control the display of the model with a visual style.

- Apply Transparency to Faces of Model Element Categories
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 3.0 Displace Element

- Displace element

Displacing elements is a view-specific override much like hiding an element in a view affects that one view only. The changes made using
Displacement will not affect the model or any other views of the model.

In the 3D view and click element  Modify tab  View panel 
Click  

Display lines that connect exploded elements to their place of origin.
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 4.0 View properties control 
- View Properties

The following properties are common to most view types.

Name Description

View Scale Changes the scale of the view as it appears on the drawing sheet. Select a scale value from the list.

Detail Level Applies a detail level setting to the view scale: coarse, medium, or fine. This setting overrides the automatic detail 
level setting for the view. 

Underlay Displays another slice of the model under the current plan view. That slice of the model can be from above or below 
the current level. The underlay appears dimmed and is visible even in hidden line. The underlay is useful to 
understand the relation of components on different floors. 

Orientation Switches the orientation of the project in the view between Project North and True North. 

Discipline Determine how elements display in the view. 

Crop View Select the Crop View check box to enable a crop boundary around the model. Select the boundary and resize it 
using the drag controls. As you resize the boundary, the visibility of the model changes. To turn off the boundary and 
maintain the cropping, clear the Crop Region Visible check box. 

View Range Within the view properties of any plan view, you can set the View Range. With View Range, you can control the 
specific geometric planes that define the boundaries of each view. These boundaries are set by defining the exact 
cut plane as well as the top and bottom clip planes.

Scope Box If you draw a scope box in a view, you can associate the view's crop region with that scope box, so the crop region is 
visible and matches the scope box extents. This property is available for plan, elevation, and section views. When 
you select a scope box value for this property, the Crop Region and Crop Region Visible properties become read-
only.
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 5.0 Use Section Box
- Section Box

This will allow you to control how much of the project is shown and is helpful for creating cutaway visualizations in real time or in renderings.

- Once a section box is enabled in a 3D view;

- Select section box in order to stretch or rotate it according to 
your need;

- The section box is not considered a crop region;

- Section box is not affected when you use the Crop Region 
Visible command

New for the 2016 release is the Selection Box tool. This is an easy 
way to isolate selected elements in the current view and switch over 
to a 3D view with only these elements visible (it also works in a 3D 
view to isolate elements). The tool enables the 3D view section box, 
which will be set to reflect the selected objects only
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 6.0 Filter setting under VV
- Filter Setting

- Similar to the filters available in schedules;

- Could either display or hide elements matching user-specified 
criteria;

- Filters can also override the graphic appearance of elements 
within a view;

- The view filters is virtually limitless to the possible combination 
and application;

Filters are another view configuration and customization tool that can be developed and deployed in Revit project templates.
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 7.0 Ramp
- Ramp

- Floor : Modify Sub Elements

- Floor : Slope Arrow

On the Architecture tab  On the Circulation panel  Click “Ramp”

Display

On the Architecture tab  On the Build panel  Click “Floor” 
Draw boundary line  Draw Slope Arrow

Click Floor element On the Shape Editing panel  Click “Modify 
Sub Elements”
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 8.0 Stair
- Stair by Sketch

On the Architecture tab  On the Circulation panel Stair drop-down  Click “Stair by Sketch”  On the Modify | Create Stairs Sketch tab 
 Draw panel  Click “Run”

When you finish the sketch, a railing is applied automatically. The Run tool limits the design of your stairs to straight runs, straight runs with 
landings, and spiral staircases. For more control when designing stairs, sketch the run by sketching the boundary and riser lines.
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 9.0 Opening
-Wall Opening

Type 1 : On the Architecture tab  Opening panel  Click “Wall” 
Sketch Rectangular Straight Wall Opening on wall element

Based on wall element, Three type of wall opening shall be created:

Type 2 : Select wall element  On the modify tab  Mode panel 
Click “Edit Profile” 

Type 3 : Create new family  Template : “Metric Generic Model wall based”  Sketch Void Forms based on wall  Cut Geometry wall and 
void forms  Load into project  On the Architecture tab  Build Panel  Component drop-down  Click “Place a component”  Click in 
the wall element
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 10.0 Interference check between Arch & Structural Model
- Elements Requiring Interference Checking

Some examples of elements that could be checked for interference include:

Structural girders and purlins Roofs and floors

Structural columns and architectural columns Specialty equipment and floors

Structural braces and walls A linked Revit model and elements in the current model

Structural braces, doors, and windows

Click Collaborate tab  Coordinate panel  Interference Check drop-down  Click “Interference Check”
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 11.0 Place Mass / Void
- Mass

During the conceptual design phase, create masses to explore ideas and perform early analyses. As the design matures, manipulate these 
forms to use as the basis for more detailed architecture.

Create walls, floor, roof and curtain system from mass instances by picking lines or faces using the model by Face tool.
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 11.0 Place Mass / Void

- Blend = Shape 1 + Shape 2 + Height

- Extrude = Shape + Height
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 11.0 Place Mass / Void

- Sweep = Shape + Path

- Revolve = Shape + Axis
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 11.0 Place Mass / Void
- Void

Create negative geometry (voids) to cut solid geometry with the Create Void tool.

1. In the drawing area  Draw a closed loop that intersects solid 
geometry

2. In the Create tab  Forms panel  Void Forms drop-down and 
click anyone 

3. Sketch the void shape on work plane
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 12.0 RC Structural elements
- Hong Kong family libraries / template

Can choose Hong Kong in content pack for download to Hong Kong standard family and the default content set US Metric.
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 13.0 Link / Bind Model
- Link Model

The most straightforward method to insert a Revit link is to use the 
Link Revit tool on the Insert tab. This exercise will take a different 
approach by using existing geometry instead in the project and 
converting it to two Revit links.

- Bind Link

Use the Bind Link tool to select the elements and datum from a 
linked model to convert to a group.
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 14.0 Placing Reinforcement – by 3D view
- Reinforcement

Use reinforcement tools to add reinforcement to structural elements*.

Click Structural element in plan view, elevation view or section view 
 In the Modify tab  Reinforcement panel  Click “Rebar” 

*Concrete columns, Beams, Walls, Foundations, and Structural floors
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 15.0 Direct build up a steel truss 
- Circular Hollow Sections (CHS)

In the 3D View  Click Structure tab  Structure panel  Click “Beam”  Click “Load Family”

Family Link : C:\ProgramData\Autodesk\RVT 2016\Libraries\Hong_Kong\Structural Framing\Steel\Hong Kong Specific\Circular Hollow 
Sections.rfa

Select one or more types on the right for each family listed on the left

In the 3D view  Based on work plane or element line  Click “3D 
Snapping” 
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 16.0 Toposurface
- Toposurface

As its name suggests, a toposurface is a surface-based representation of the topography context supporting a project. It is not modeled as a 
solid in Revit Architecture. However, a toposurface will appear as if it were a solid in any section cut view.

Based on Topographic Survey Plan, Four type of topography shall be created:
1. Existing Ground - Import the 3D Map into Revit project.
2. Site Survey - Split Surface for site boundary on Existing Ground. (Existing Ground should be preserved)
3. Reference - Reference is modelled is modelled for calculation.
4. Excavation / Back Fill (e.g. Cut Slop, Berm /Platform) - The toposurface shall be split at different parts of the excavation profile.
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 17.0 Curtain System
- Create a curtain system of a mass / generic models face

Based on mass / generic models  On the Architecture tab  Build panel  Click “Curtain System”  Pick a mass / generic models face 
to create curtain system  



ADVANCED CONSTRUCTION INFORMATION DEVELOPMENT

Basic Setting

 17.0 Curtain System
- Edit a curtain system

Select a curtain system  In the Properties Browser  Click “Edit Type”  User can edit the horizontal and vertical grid layout and spacing 
and choose the mullions type to follow the grid
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 18.0 Room / Area
- Defining rooms in spaces

In the floor plan view  Architecture tab  Room & Area panel drow-down  Click “Area and Volume Computations”  In Room Area 
Computation  Click” At wall core layer”

- Set up room bounding (wall)

Click wall element  In the properties browser  Based on constraints  Click room bounding for architectural wall or unclick for structural 
wall
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 18.0 Room / Area
- Separation Line

Room boundaries are automatically defined by many tapes to model elements. User can add separation lines to add and adjust room 
boundaries.

Architecture tab  Room & Area panel  Click “Room Separator”  Draw the room separation line in plan view
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 19.0 Wall, Door, Window
- Wall

On the Architectural tab  Click “Wall”  Choose draw tool from the draw gallery

User can set a few parameters before user draw your wall.
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 19.0 Wall, Door, Window
- Preliminary Design - Detail Design / Coordination

Select Wall  In the Properties Browser  “Edit Type”  In “Structural” Parameter click “Edit”

- Set up material and add wall finish
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 19.0 Wall, Door, Window
- Door

Based on walls element  On the Architecture tab  Click “Door”

- Window

Based on walls element  On the Architecture tab  Click “Window”
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 20.0 Apply material to Revit Model
- Materials Library

On the manage tab  Settings panel  Click “Materials”  Drop – down                Click “Create new material”  Click

Double click a material to replaces the current asset in the editor with this asset  Right click to rename the materials  Edit the materials 
setting in the right tab  Click OK



Skills for Create 2D Drawing
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 1.0 Create New Sheets in Revit
- Sheet

On the view tab  Sheet composition panel  Sheet  Select the sheet type

In the Project Browser, expand the list of views, locate the view, and drag it onto the sheet.
- To add views to a sheet

- Modify a View on a Sheet

1. In the drawing area, select a view on the sheet.
2. Click Modify | Viewports tab  Viewport panel  Activate View
3. Change the scale of the view. On the View Control Bar, for Scale, select the desired scale.
4. To deactivate the view on the sheet, double-click outside of the view, or right-click, and click Deactivate View.
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 2.0 View Range Setting
- View Range

In the properties browser  Under extents  View Range  Click “Edit”

1. Top

2. Cut plane

3. Bottom

4. Offset

5. Primary Range

6. View Depth
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 3.0 Show Part View (Plan Region)
- Using Plan Region

The Plan Region tool allows user to sketch a boundary line within which the View Range dialog box will be available to make specific 
changes.

On the view tab  Create panel  Drop-down plan view Click “Plan Region”
Sketch the boundary  Set the plan region view range

- Create Plan Region
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 4.0 Show Crop Region & How to Crop View
- Using Crop Region

With the exception of schedules and drafting views, the extents of all views can be limited using crop regions.

- Show Crop Region
In the view control bar  Click “Show Crop Region” and Click “Crop Region”

- Edit a Crop Region

In the plan, elevation, or section view  select a crop region  In the Edit modify | <view> tab  Model panel  Edit Crop
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 5.0 Create Detail Group
- Using Detail Group

Detail groups are similar to blocks in AutoCAD and are a quick alternative to creating detail component families. Like modeled groups, these 
are a collection of graphics that contain detail lines, detail components, or 2D elements.

- Create Detail Group

Select 2D element  On the modify tab  Create panel  Click “Create Group”

- Edit Detail Group

Click the detail group  In the modify | detail groups  Group panel  Click “Edit Group”  Add or Remove the element in the group
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 6.0 Drafting View
- Using Drafting View

Drafting views give user the ability to draw without first creating a reference to something in your project.

- Create Drafting View

On the View tab  Create panel  Click “Drafting View”  In the new drafting view browser  Set up view name and scale

User can refer to this view when creating an elevation, section, detail, and so on that would normally rely on an actual view of the model.
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 7.0 Explode Import CAD Drawing to Create Detail Item from CAD
- Create Detail Item family

Create new families  Select template file : Metric Detail item

- Import CAD file

On the Insert tab  Import panel  Click “Import CAD”

1. Click “Current view only”
2. Set up the import units follow the CAD drawing units
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 8.0 Masking Region Under Detail Panel
- Masking Regions

Typically used to “hide” or mask certain content from a view that user don’t want shown or printed.

- Create Masking Regions

On the annotate tab  Detail panel  Region drop – down  Click “Masking Region”

Create Masking Region Boundary  Select line type
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 9.0 Detail Component
- Detail Component

They are most often used in drafting views; however, detail components can also be placed in plan, elevation, and section views.

1. Select Detail Component from the Component drop-down menu list located on the Annotate tab.

2. Use the Type Selector to choose from detail components that are already inserted into the model.

On the annotate tab  Detail panel  Component drop – down  Click “Detail Component”
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 10.0 Hide in Viewv
- Hide in View

User can hide individual elements or categories of elements in a view permanently or temporarily.

- Use Hide in View

In the View  Right Click the element  Click “Hide in View”  Choose “Elements”, “Category” and “By Filter”

- Unhide in View

On the View Control Bar  Click            Right click the hide element  Click “Unhide in View”  Choose “Elements”, “Category” and “By 
Filter”



ADVANCED CONSTRUCTION INFORMATION DEVELOPMENT

Basic Setting

 11.0 Control Visibility / Properties of Element in View
- Visibility Graphics(VV/VG)

Controls the visibility and graphic display of model elements, datum elements, and view specific elements for each view in a project. 
The Visibility/Graphic Overrides dialog box allows overrides of elements in two essential ways: visibility (turn object categories on/off) and 
graphics (customize line thickness, color, and fill pattern).
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 12.0 Linework
- Linework*

The Linework tool allows you to modify the edges of model elements in a view-specific context.

*This tool is not available in a drafting view because it works only on model elements.

- Use the Linework

On the Modify tab  View panel  Linework  Choose the line style in the selector panel
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 13.0 Create & Edit New Line Patterns & Line Styles
- Set up Line Patterns

On the manage tab  Settings panel  Drop – down additional settings  Click “Line Patterns”

Click “New”  Made up of dashes, dots, and spaces
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 13.0 Create & Edit New Line Patterns & Line Styles
- Set up Line Styles

On the manage tab  Settings panel  Drop – down additional settings  Click “Line Styles”

Click “New”  Set line weight, color, and patterns
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 14.0 Line Weight setting
- Line Weights

On the view tab  Sheet Composition panel  Sheet  Select the sheet type
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 15.0 Fill Pattern
- Fill Pattern

Materials are often represented with simple hatch patterns. For any material used, user can define a surface pattern and a cut pattern.

On the manage tab  Settings panel  Additional settings drop – down  Click “Fill Pattern”

- Set up Fill Pattern

- Sketch Fill Pattern

On the annotate tab  Detail panel  Drop – down region  Click “Fill Pattern”
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 16.0 RVT Link Display Settings
- Display Settings

On the view Click VV (Visibility/Graphic Overrides) Click Revit Links tab  Choose the link and click the button in the display settings

To begin customizing the display of elements in the linked file, user 
must first choose the custom option in the Basics tab.

Select the Model Categories tab and choose <Custom> in the drop-down list at the top of the dialog box
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 17.0 Linked View
- Linked View

Select the view in the linked model whose display settings user want to use for the linked model in the current host view.

For example, if the selected view has a filter applied, then that filter will apply to the linked model in the current host view, too.
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 18.0 Change Level Head Family & Adjust Unit Format
- Level Head

Open the Family “M_Level Head – Triangle”
Family Path : C:\ProgramData\Autodesk\RVT 2017\Libraries\US Metric\Annotations

- Set up unit format

In the Manage tab  Settings panel  Click “Project Units” 
Choose Length and click the button in the format  Edit the unit and 
rounding

- Set up unit symbol

Click “Elevation”  In the modify tab  Click “Edit Label”  Label Parameters  Add a suffix to the parameter value by adding a text string 
in this column.
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 19.0 Create Schedule
- Schedule

On the view tab  Create panel  Schedules drop – down  Click “Schedule/Quantities”  Select Category

Add the fields from Available fields to Scheduled fields: Select parameter in Available fields box  Click “Add”
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 19.0 Create Schedule
- Add Parameter

Click “Add Parameter”  Pick “Share Parameter”  Click “Select”  Choose a parameter group, and a parameter  Click OK

- Calculated Value
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 20.0 Group the Header at Schedule
- Header at Schedule

See examples of sorting and grouping for schedules, including itemizing instances, sorting, and totals.
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 21.0 Create Sheet List
- Sheet List

On the view tab  Create panel  Schedules  drop – down  Click “Sheet List”
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 22.0 Create New View Template
- View Template

A view template is a collection of view properties, such as view scale, discipline, detail level, and visibility settings.

- Create View Template

On the View tab  Graphics panel  View Templates drop – down  Click “Create Template from Current View”

- Apply View Template

Click “Apply Template from Current View”  View type filter drop –
down  Select <all>
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 23.0 Callout
- Callout

Shows some portion of another view at a larger scale. In a construction document set, use callouts to provide an orderly progression of 
labeled views at increasing levels of detail.

On the view tab  Create panel  Callout drop – down  Click “Rectangle” or “Sketch”

Right click callout boundary  Click “Go to View”
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 24.0 3D Dimension / 2D Dimension 
- Dimension

On the annotate tab  Dimension panel  Choose the dimension type and click it

- Create Dimension in 3D View

In the work plane panel  Click “Set”  Set the work plane in the 3D view  Use the Dimension tool

Horizontal Plane Vertical Plane
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 1.0 Export Revit project 
- DWF/ DWFx

User can view files in DWF/ DWFx format. If user export sheets to DWFx and the markups are linked back into Revit, the markups will be 
automatically placed on the corresponding sheet.

- Export DWF/ DWFx

Select the Application Menu  Choose Export  DWF/ DWFx  In the DWF Export Settings dialog box  Select the sheet or view and 
click “Next”
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 1.0 Export Revit project 
- Markup in Autodesk Design Review

Open the DWFx  Choose the Markup & Measure tab  Draw panel

On the Insert tab  Link panel  Click “DWF Markup”

- Insert Markup to Revit

In the Link Markup Page to Revit Sheets dialog box  Select the markup view
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 2.0 Compare different version
- Compare Sheets

In the Autodesk Design Review  On the tools tab  Canvas panel  Click “Compare Sheets”

In the Compare dialog box  Select file  Select sheet to compare  Click “OK”
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 3.0 Print setup for hardcopy 
- Print PDF

1. Select the application menu  Choose print  Click print  In the printer panel  Select printer

2. Print range panel  Choose Selected view/sheets  Click 
“Select”  Select view and sheets

3. In the settings panel  Click “Setup”  Follow sample print setup 
dialog box setting
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 4.0 ACS Plugins – GBP Submission

Automatic calculations refer to a script or plug-in which will automatically refer to the statutory tables for GBP 
Submission and perform the calculation, returns with a result and fill in the requirement schedule such as Site 
Coverage & Plot Ratio, List of GFA Concession, Fire Resistance, Provision of Exit Doors & Exit Routes, 
Provision of MOE, Sanitary Fitments calculation etc.

- Automatic Calculation System 



ADVANCED CONSTRUCTION INFORMATION DEVELOPMENT

Basic Setting

 4.0 ACS Plugins – GBP Submission
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 5.0 Export Revit model to Fuzor
- Fuzor

In the 3D view  On the Fuzor Plugin tab  Click “Launch Fuzor 2017 Ultimate”

In the Fuzor Revit Documents Manager dialog box  Choose the 
link file to sync  Select By Linked VG and choose the view

In the Fuzor panel  Click the document tab  On the Fuzor
Project Panel  Click Save to Export CHE file for Fuzor



Family
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 1.0 Select Suitable Template for Creating New Family
- Create New Family

In the start menu  Families panel  Click “New”  Choose the suitable template*

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Family Templates\English
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 2.0 Shared Parameter & Project Parameter
- Create Project Parameter

On the Manage tab  Settings panel  Click “Project Parameters”  Click “Add”

Categories is the list of element types in which this new property will appear. This is where you define all the category types you’ll associate 
with the new parameter. Category selections are flexible. If you decide you need to change categories after you create your parameter, you 
can easily come back to the Project Parameters tool and modify your selection.

- Click “Project parameter” (1)

- Set the Name (2)
This is used for describing the parameter as well as referencing it in schedules and the Properties palette.

- Choose type of parameter (3)
Choosing between project and shared parameter is the first choice you’ll need to make. We’ll get to shared parameters later, so for now, 
leave it at the default of Project Parameter.

- Click “Type” or “Instance” (4)
Set to Instance. This setting controls the uniqueness of the parameter itself. Both parameter types can be mixed within a given family. In this 
example, use an instance parameter because a user wants to designate whether something is reusable on an element-by-element basis.

- Select Categories (5)
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 2.0 Shared Parameter & Project Parameter

1

3

4

5

2
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 2.0 Shared Parameter & Project Parameter
- Create Shared Parameter

On the Manage tab  Settings panel  Click “Shared Parameters”  Click “Create”

In the Edit Shared Parameters Dialog, user can create a Parameter group and add new parameters in 
Parameter group

- Create New Parameter Group

In Group panel  Click “New”  Set the group name

In Parameter panel  Click “New”  Set parameter name  Choose type of parameter 

- Create New Parameters

- Set up Shared Parameter in Project

On the Manage tab  Settings panel  Click “Project Parameters”  Click “Add”  Click “Shared 
parameter” (1)  Click “Type” or “Instance” (4)  Select Categories (5)

Project Parameter Shared Parameter

Appear in schedule O O

Be used in tags X O

Be used in multiple projects + families X O

Be used in Key schedule to drive main schedule O X

- Project Parameter vs. Shared Parameter
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 3.0 Create Tag Family
- Tag Family

If user want to be able to both schedule and tag your parameter, it will need to create a shared parameter

Select the application menu  Choose “New”  Click “Family  Choose the family template in the Annotations folder  Use the suitable 
template

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Family Templates\English\Annotations

- Create Tag Family
On the Create tab  Text panel  Click “Label”  In the Edit Label dialog box  Click “Create” (1)

1

- Set up Parameters
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 4.0 Purge Unused Items
- Purge Unused

If your file is very large, it can take several minutes to run, but eventually user will be presented with a list of all the unused elements within 
your file.

On the Manage tab  Settings panel  Click “Purge Unused”  In Purge unused dialog box  Click the item as user will delete it
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 5.0 Making Family Tools
- Family Tools

There are five discrete geometry types in the Family Editor: Extrusion, Sweep, Blend,
Revolve, and Swept Blend. Both solid and void forms can be modeled from these shapes.

Example Description

Extrusion A solid or void extrusion is the easiest form to create. 
You sketch a 2D profile of the form on a work plane, 
and then extrude that profile perpendicular to the plane 
on which you sketched it.

Click “Extrusion”  Sketch the profile

Blend The Blend tool blends 2 profiles (boundaries) together. 
For example, if you sketch a large rectangle and a 
smaller rectangle on top of it, Revit LT blends the 2 
shapes together.

Click “Blend”  Sketch the base profile Click “Edit 
Top” on the Modify tab  Sketch the Top profile
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Example Description

Revolve A revolve is a form that user create by revolving a 
shape around an axis. User can revolve the shape in a 
circle or any fraction of a circle. If the axis touches the 
revolve shape, the result is a solid.

Click “Revolve”  Sketch the revolve  Sketch a 
closed loop  Click “Axis Line” on the Modify tab 
Specify the start and endpoint of the axis at the desired 
orientation

Sweep Create a 3D shape by sweeping a 2D profile along a 
path.

Click “Sweep”  Click “Sketch Path”  Sketch a 
single closed or single open path  Click “Select 
Profile” on the Modify tab  Click Edit Profile 
Sketch the profile

Swept Blend The Swept Blend tool allows you to create a blend that 
has 2 different profiles and then sweep it along a path. 

Click “Swept Blend”  Click “Sketch Path”  Sketch a 
path  Click “Select Profile 1” on the Modify tab 
Click Edit Profile  Sketch the profile  Click “Select 
Profile 2” on the Modify tab  Click Edit Profile 
Sketch the profile

 5.0 Making Family Tools
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 6.0 Introducing Generic Model Under Family
- Generic Model

If no suitable template for create family, we suggest use generic model template to create it. Generic model haven’t any information and 
default parameters, so user need set up the parameters in family for family information

Select the Application menu  Choose New  Click “Family”  Choose the family 
template “Metric Generic Model”*

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Family Templates\English

Generic Model template have different base template

- Generic Model Type
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 7.0 Work Plane / Reference Plane / Reference Line
- Work Planes

A work plane is a virtual 2-dimensional surface, it is used in the following ways :

1. As the origin for a view

2. For sketching elements

3. For enabling tools in particular views, such as Rotate and Mirror in a 3D view

4. For placing work plane-based components

- Set Work Planes

On the Architecture/ Structure/ Systems tab Work Plane panel  Click “Set”

In the Work Plane dialog box :
1. Click “Name”  Select plane follow from the list, includes level, grid or reference 

plane

2. Click “Pick a plane”  Select any plane that can be dimensioned, including wall 
faces, faces in linked models, extrusion faces, levels, grids, and reference planes

3. Click “Pick a line and use the work plane it was sketched in”  Revit creates a work 
plane that is coplanar with the work plane of the selected line

- Show Work Planes

On the Architecture/ Structure/ Systems tab Work Plane panel  Click “Show”
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 7.0 Work Plane / Reference Plane / Reference Line
- Reference Plane

These define a single plane that can be set to host sketch lines or geometry

By definition these datum objects have endpoints and are great for controlling angular and directional relationships

- Reference Line

They’re best for controlling linear geometric relationships—that is to say, geometry that will flex in a linear fashion. Reference planes don’t 
have endpoints. This is important because user don’t want to use reference planes for controlling angular or directional relationships.

They can have four axes of reference, two along the length of the line (which are perpendicular to each other) and one at each end that is 
perpendicular to the line. User can also creates curved reference lines, but they have only planes that may be used for hosting at each end. 
There are no references along the curved line.

- Reference Plane Sample : - Reference Line Sample :



ADVANCED CONSTRUCTION INFORMATION DEVELOPMENT

Basic Setting

 8.0 Change Generic Model to Structural Elements
- Change the category

Select the Application menu  Choose New  Click “Family”  Choose the family template “Metric Generic Model”*  On the Create tab 
 Properties panel  Click “Family Category & Parameters”  In the dialog box  Select the Structural Connections on the list

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Family Templates\English

- Change the category when no suitable family template

1. Air Terminals

2. Cable Tray Fittings

3. Communication Devices

4. Conduit Fittings

5. Duct Accessories

6. Duct Fittings

7. Lighting Devices

8. Nurse Call Devices

9. Pipe Accessories

10. Pipe Fittings

11. Security Devices

12. Sprinklers

13. Structural Connections
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 9.0 Nested Family
- Nested Family

User can nest (insert) families within other families to create new families that contain the combined family geometry

When user create a nested family of shared components, the first decision user need to make is what category the host family is belongs to. 
This decision has many downstream implications for tagging, scheduling, and ODBC information, as described in the examples below.

- Nested and shared families loaded into a project

Notice the double hung windows are tagged and scheduled separately. The fixed window that was the host is not included in the schedule 
and not tagged. However, notice the ganged window name, Gang _ Fixed Host, is listed with the subcomponents. This window represents 
the main window composed of the of the  3 subcomponent windows.

In order to get both the fixed and double hung sub-component windows to tag and schedule, the same triple window family was created, but 
this time a new window family is used as the host family and both the fixed window and the double-hung windows loaded as shared 
families. Notice the difference in the tagging and scheduling.
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 10.0 Symbol /  Leader with Text
- Placing Annotation Symbols

Much like detail components, annotation symbols are families that contain only 2D graphics including lines, text, and fill or masking regions

- Create Symbol

Select the Application menu  Choose New  Click “Family”  Choose the family template “Metric Generic Annotation”*  On the Create 
tab  Detail panel  Click “Line” for draw symbol and Click “Filled Region” for fill the pattern in symbol (User draw the symbol scale need 
1:1)

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Family Templates\English\Annotations

- In Family - In Project (1:100)
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 10.0 Symbol /  Leader with Text
- Add Leader

In the project  Click the symbol element  On the Modify tab  Leader panel  Click “Add”  And click the symbol element  Click 
“Edit Type” in the Properties browser  Choose the Leader Arrowhead type

- Add Text

In the Family  On the Create tab  Text panel   Click “Label”  Add the parameter in family
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 11.0 3 Point Set Up Plane 
- Unique a Work Plane

If user can’t set up the unique work plane, we suggest create a 3 
point family to supply user find the plane

- Create family

Select the Application menu  Choose New  Click “Family”  Choose the family template “Metric Generic Model Adaptive”*  On the 
Create tab  Draw panel  Click “Reference”  Choose “Line” and Click “3D Snapping”  Draw the triangle in view and Click it  Click 
“Create Form” on the modify tab and choose face solid form

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Family Templates\English

- Use the 3 point family

Select 3 reference point  Click “Make Adaptive” on the modify tab 
 Click “Load into Project”  Click “Component” and use it  Click 
“Set” on the architecture tab and click “pick a plane”  Pick a face 
to set up unique plane



Annotation
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 1.0 Apply Keynote for All Structural Materials
- Keynotes

A keynote parameter is available for all model elements (including detail components) and materials. User can tag each of these elements 
using a keynote tag family. The keynote value is derived from a separate text file that contains a list of keynotes.

- Keynoting Settings

1. On the annotate tab  Tag panel  Keynote drop – down  Click “Keynoting Settings”  In the Keynoting Settings browser  Go to file 
location to edit Keynote file (User can click “View” open the keynote list)
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 2.0 Tag
- Tag

It is Annotation for identifying elements in a drawing. Tags are text labels for elements such as doors, walls, windows, rooms, and several 
other objects that architects typically need to refer to in a set of drawings.

- Tag By Category

The Tag By Category button is possibly one of the most frequently used Tag commands

On the Annotate tab  Tag panel  Click “Tag By Category”  Click a single element in 2D 
view

- Tag All

The Tag All button, which activates the Tag All Not Tagged command, will do exactly that: tag all 
the untagged elements of a selected category within a given view

On the Annotate tab  Tag panel  Click “Tag All”  Select the element categories to tag all 
 Can click Leader to tag (if it is link file, click include elements from linked files)



Steel
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 1.0 Load Structural Steel Family
- Steel

Suggest to choose Hong Kong in content pack for download to Hong Kong standard steel and the default content set US Metric as install 
Revit.

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Libraries\Hong_Kong\Structural Framing\Steel\Hong Kong Specific

On the Structural tab  Structure panel  Click “Beam”  On the 
modify tab  Click “Load Family”  Choose the family by structural 
framing*



ADVANCED CONSTRUCTION INFORMATION DEVELOPMENT

Basic Setting

 2.0 Create Steel Family  - Beams and Braces & Detail Item
- Create Steel Family

Select the Application menu  Choose New  Click “Family”  Choose the family template “Metric Structural Framing - Beams and 
Braces”  Go to elevation view – Left or Right  Click element  In the Modify tab  Click “Edit Extrusion”

- Detail Item – Break Line

On the Annotate tab  Detail panel  Component drop – down  Click “Detail Component”  Choose the family category by Detail Item 
 Choose “M_Break Line”* ( Need modify this family for Circular Hollow Sections)

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Libraries\Hong_Kong\Detail Items\Div 01-General
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 3.0 Steel connection at corner 
- Steel Join

Confirm Structural Framing end point same location  On the Modify tab  Geometry panel  Click

Click the arrow, a longer beam is cut back from a shorter beam
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 4.0 Copping Steel Member
- Cope

Coping applies to steel beams and column, such as locations where beams frame into grids  On the Modify tab  Geometry panel 
Click “cope”

A

B

First click A, then click B  Select A element  In the Properties  Structural list  Set up the coping Distance to 1
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 5.0 Connection Details/ Stiffener, Gusset Plate
- Structural Stiffener

On the Structure  Model panel  Component drop – down  Click “Place a Component”  On the Properties palette  Type selector 
drop – down  Select a stiffener type 

- Gusset Plate
On the Structure  Model panel  Component drop – down  Click “Place a Component”  Click “Load Family”  Choose the family on 
Structural Connections*

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Libraries\Hong_Kong\Structural Connections\Steel
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 6.0 Load & Create Bolt Detail
- Load Bolt & Nuts

On the Structure  Model panel  Component drop – down  Click “Place a Component”  Click “Load Family”  Choose the family on 
Structural Connections*

*Family Path : C:\ProgramData\Autodesk\RVT 2016\Libraries\Hong_Kong\Structural Connections\Mounting Parts\Anchor Bolts

- Create Bolt & Nuts

Select the Application menu  Choose New  Click “Family”  Choose the family template “Metric Generic Model face based”  On the 
Create tab  Properties panel  Click “Family Category & Parameters”  Click Structural Connections on the Family Category list
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 7.0 Edit Analytical Model Node
- Analytical Model

In the view  Open Visibility / Graphic Overrides  On the Analytical Model Categories  Click “Analytical Nodes”  Click                          



Miscellaneous
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 1.0 Family Library Interchange Program
- FLIP

Family Library Interchange Program (FLIP) is the collaboration between Autodesk Far East Ltd and local BIM Consultant Advanced 
Construction Information Development Ltd (A.C.I.D.) and Synnex Technology International (HK) Ltd. 

It is a well-organized web-based platform that standardized and localized Families are stored and categorized according to strict guidelines. 
Naming convention, styles, level of details and parametric properties are systematically organized according to local practices.

Suggested Family Type for use with the FLIP System based on FLIP-specific naming convention system and technical consideration for the 
local market

Website : http://www.aiab.org/index.php/flip-guideline
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 2.0 Exchange Apps
- Exchanges Apps

Autodesk Exchange Apps is an online resource where you can browse and purchase Apps (including product-specific content such as 
models, training materials, and eBooks) – and is available to several Autodesk Products.
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 3.0 Revit Formulas for "everyday" usage
- Exponentiation

XY = X ^ Y

- Circles with pi π

Usage in Revit = pi()
Circumference = pi() * (Radius * 2)
Circumference = pi() * Diameter
Circle Area = pi() * Radius ^ 2

- Conditional statements

Conditional statement uses this structure:
IF (<condition>, <result-if-true>, <result-if-false>)

Supported Conditional Operators
< Less than
> Greater than
= Equal
/ Divide
AND Both statements are true
OR One of the statements is true
NOT Statement is false

- Round Function In Formulas

ROUND(x) round ( 23.4) = 23
round ( 23.5) = 24
round ( 23.6) = 24
round (-23.4) = -23
round (-23.5) = -23
round (-23.6) = -24

ROUNDDOWN(x) rounddown ( 23.0) = 23
rounddown ( 23.5) = 23
rounddown ( 23.9) = 23
rounddown (-23.0) = -23
rounddown (-23.5) = -24
rounddown (-23.9) = -24

roundup ( 23.0) = 23
roundup ( 23.5) = 24
roundup ( 23.9) = 24
roundup (-23.0) = -23
roundup (-23.5) = -23
roundup (-23.9) = -23

ROUNDUP(x)

- More Revit Formulas

Website : http://www.revitforum.org/tutorials-tips-tricks/1046-revit-formulas-everyday-usage.html
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 4.0 Keyboard shortcut
- Keyboard Shortcuts (K+S)

You can edit your keyboard shortcuts without the hassle of rooting through your hard drive looking for a TXT file
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 5.0 Recover Collapse Model from Existing and Backup Version
- Restore a Previous Version of a Server-Based Central Model

When using server-based worksharing, you can restore an earlier version of a central model

Locate the backup folder for the central model, and copy this folder to another location  On the Collaborate tab  Manage Models panel 
 Click “Restore Backup”  In the Browse for Folder dialog, navigate to the copy of the backup folder for the central model  Click Open.

Select the file version whose date and time correspond most closely to the period user wish to roll back to  Click Save As to save this 
older version as a new model



Thank you !
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